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In this manual we have tried as much as possible to describe all the
various matters.
However, we cannot describe all the matters which must not be done,
or which cannot be done, because there are so many possibilities.
Therefore, matters which are not especially described as possible in
this manual should be regarded as ”impossible”.

The export of this product is subject to the authorization of the
government of the country from where the product is exported.

� No part of this manual may be reproduced in any form.

� All specifications and designs are subject to change without notice.



B-63164EN/04                                                                                                           SAFETY PRECAUTIONS

s-1

SAFETY PRECAUTIONS
This manual includes safety precautions for protecting the user and
preventing damage to the machine. Precautions are classified into
Warnings and Cautions according to their bearing on safety. Also,
supplementary information is described as Notes. Read the Warnings,
Cautions, and Notes thoroughly before attempting to use the machine.

 WARNING
Applied when there is a danger of the user being
injured or when there is a damage of both the user
being injured and the equipment being damaged if
the approved procedure is not observed.

 CAUTION
Applied when there is a danger of the equipment
being damaged, if the approved procedure is not
observed.

NOTE
The Note is used to indicate supplementary
information other than Warning and Caution.

- Read this manual carefully, and store it in a safe place.
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GENERAL WARNINGS AND CAUTIONS

The following warnings and cautions describe the safety precautions
related to the use of CNC units. It is essential that these precautions
be observed by users to ensure the safe operation of machines
equipped with a CNC unit.

 WARNING
1 Before operating the machine, thoroughly check the entered

data. Operating the machine with incorrectly specified data
may result in the machine behaving unexpectedly, possibly
causing damage to the workpiece and/or machine itself, or
injury to the user.

2 Never attempt to machine a workpiece without first checking
the programmed value, compensation value, current position,
and external signal settings. Also, never attempt to machine a
workpiece without first checking the operation of the machine.
Before starting a production run, ensure that the machine is
operating correctly by performing a trial run using, for
example, the single block, feedrate override, or machine lock
function, or by operating the machine with neither a tool nor
workpiece mounted. Failure to confirm the correct operation of
the machine may result in the machine behaving
unexpectedly, possibly causing damage to the workpiece
and/or machine itself, or injury to the user.

3 Ensure that the specified feedrate is appropriate for the
intended operation. Generally, for each machine, there is a
maximum allowable feedrate. The appropriate feedrate varies
with the intended operation. Refer to the manual provided with
the machine to determine the maximum allowable feedrate. If
a machine is run at other than the correct speed, it may
behave unexpectedly, possibly causing damage to the
workpiece and/or machine itself, or injury to the user.

4 When using a tool compensation function, thoroughly check
the direction and amount of compensation.
Operating the machine with incorrectly specified data may
result in the machine behaving unexpectedly, possibly causing
damage to the workpiece and/or machine itself, or injury to the
user.

5 The parameters for the CNC and PMC are factory-set.
Usually, there is no need to change them. When, however,
there is no alternative other than to change a parameter,
ensure that you fully Failure to set a parameter correctly may
result in the machine behaving unexpectedly, possibly causing
damage to the workpiece and/or machine itself, or injury to the
user.
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 CAUTION
1 The operator's manual on the CNC screen display function

does not cover the functions and operation of CNCs. For
details of the functions and operation of a CNC, refer to the
operator's manual for the CNC.

2 Some machine operations and screen functions are
implemented by the machine tool builder. For an explanation
of their usage and related notes, refer to the manual provided
by the machine tool builder.

3 The CNC screen display function is designed to allow
standard CNC screens to be displayed on the monitor of a
personal computer. With this function, the same operation as
the standard CNC operation can be performed. However,
there are some operations that cannot be performed with this
function. For details, see the notes and limitations described in
this manual.

NOTE
Command programs, parameters, and variables are stored in
nonvolatile memory in the CNC. Generally, the contents of
memory are not lost by a power on/off operation. However, the
contents of memory may be erased by mistake, or important
data in nonvolatile memory may have to be erased because of
recovery from a failure.
To enable the restoration of data as soon as possible if such a
situation arises, always make a backup of the data.
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WARNINGS AND CAUTIONS RELATING TO THE CNC SCREEN
DISPLAY FUNCTION

Warnings and cautions relating to the CNC screen display function
are explained in this manual. Before using the function, read this
manual thoroughly to become familiar with the provided Warnings,
Cautions, and Notes.

 CAUTION
1 This manual does not explain in detail those

operations and parameters that vary from one CNC
model to another and which vary with options. For
an explanation of such operations and parameters,
refer to the relevant CNC manual and the manual
supplied by the machine tool builder.

2 This manual describes as many reasonable
variations in usage as possible. It cannot address
every combination of features, options, and
commands that should not be attempted. If a
particular combination of operations is not
described, it should not be attempted.



B-63164EN/04                                                                                                                                        PREFACE

p-1

PREFACE
Thank you for purchasing the FANUC Open CNC CNC screen
display function.

The FANUC Open CNC CNC screen display function (simply called
"CNC screen display function" from here on) allows the same display
and operation as the FS16i/18i/21i, FS15i, or FS15B to be performed
on a personal computer connected to the FS16i/18i/21i, FS15i, or
FS15B via the high-speed serial bus Type 2, the FS160i/180i/210i or
FS150i with a CNC Display Unit with Personal Computer Function,
the FS160i/180i/210i with the personal computer function, or a
personal computer connected to the FS16i/18i/21i via the Ethernet,
the FS160is/180is/210is with a Display Unit for is Series CNC and
the FS160is/180is/210is with the personal computer function.

NOTE
See Appendix 2, "CNC Screen Display Function for
the FS160is/180is/210is," for explanations about
the CNC screen display function for the
FS160is/180is/210is with a Display Unit for is
Series CNC and the FS160is/180is/210is with the
personal computer function.

The CNC screen display function is supported by Microsoft�

Windows� 95/98/NT4.0/2000/CE. This manual does not explain the
basic common operations of Windows.
Users who are using Windows for the first time should read the
manuals on Windows first to become familiar with the basic operation
of Windows.

Read this manual thoroughly to ensure the correct use of the CNC
screen display function.

 CAUTION
FANUC holds the copyrights on this software
product and associated manuals and other
documents. Only one backup copy of this software
product is permitted. Reproduction for other
purposes is not allowed. This software can be
installed on one computer only.

The CNC screen display function uses the following product for
which copyright is held by Microsoft Corporation:
  • Microsoft� Windows� Visual C++TM

Microsoft, Windows are registered trademarks of Microsoft
Corporation.
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FEATURES AND LIMITATIONS OF THE CNC SCREEN DISPLAY
FUNCTION

The CNC screen display function has the following features:

Features
� This function enables the same display and operation as for the

Series 16i/18i/21i, Series 15i, or Series 15B to be performed on
Windows, providing a more user-friendly environment.

� This function enables user-created screens (screens created using
C Executor, Macro Executor, PMC C) to be displayed.

Note the following limitations:

Limitations

 (1) Operating environment
� This software is designed specifically for a personal computer

connected to the FS16i/18i/21i, FS15i, or FS15B via the high-
speed serial bus Type 2, the FS160i/180i/210i or FS150i with a
CNC Display Unit with Personal Computer Function, the
FS160i/180i/210i with the personal computer function, and a
personal computer connected to the FS16i/18i/21i via the
Ethernet. This software cannot be used with other CNCs.

� This software supports the following CNCs:
HSSB version:
FS160i-M/T, FS180i-M/T, FS210i-M/T, FS150i/MA (with a
CNC Display Unit with Personal Computer Function or with the
personal computer function )
FS16i-M/T, FS18i-M/T, FS21i-M/T, FS15i-MA T FS15-
MB/MBMA/MBMA2 (a personal computer connected via the
high-speed serial bus Type 2)
Ethernet version
FS16i-M/T, FS18i-M/T, FS21i-M/T

 (2) Display
� The screen size is always 640 by 480 dots, regardless of the

resolution of the personal computer.

� Use the personal computer in more than 256-color display mode.
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� The FS160i/180i/210i with the personal computer function, the
FS160i/180i/210i or FS150i with a CNC Display Unit with
Personal Computer Function, and a personal computer connected
to the FS15i or FS15B via the high-speed serial bus Type 2 can
display 14" images only. A personal computer connected to the
FS16i/18i/21i via the high-speed serial bus Type 2 and a
personal computer connected to the FS16i/18i/21i via the
Ethernet can display both 9" images (including monochrome
images) and 14" images.

� When this software is used with a personal computer connected
to the FS16i/18i/21i, the FS15i, or the FS15B via the high-speed
serial bus Type 2 or a personal computer connected to the
FS16i/18i/21i via the Ethernet, the LCD display and MDI
keyboard on the CNC cannot be used during execution of the
CNC screen display function.

� When the CNC is in graphic display mode (for example, a tool
path is being drawn), executing the CNC screen display function
does not produce a graphic display which is already drawn. Also
when the CNC screen display function is terminated while
graphic display is being performed on the CNC screen display
function side, no graphic display is produced on the CNC side.
Graphic display must be performed again on each side
respectively.

� The boot screen cannot be displayed.

� When characters and graphics are overlaid on one another,
composite colors cannot be displayed. One of the colors, that of
the characters or that of the graphic, must be specified as the
priority color. (The default color is that of the characters.)

� Color palette numbers 0 to 15 and 240 to 255 are unavailable
because they are reserved by Windows. Therefore, when a
screen created in 256-color mode is displayed with the CNC
screen display function, the colors corresponding to these color
palette numbers are not displayed correctly.

� Screen programs created with the C Executor must be
recompiled by using a library supporting the CNC screen display
function supplied by FANUC. (FS15i or FS15B is not supported
C language Executor function.)

�Conversational programming functions ( such as Manual Guide
M/T, Super CAPi M/T, Symbol CAPi T) are valid for
FS160i/180i/210i MODEL B with a CNC Display Unit with
Personal Computer Function only.
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 (3) Operation
� The memory card utility supported by the CNC screen display

function of the FS160i/180i/210i with the personal computer
function can be used only for the input/output of data. The types
of the input/output data are the same as those of the data that the
standard FS16i/18i/21i can input and output with the memory
card (except for C Executor-created application data, which can
be neither input nor output). PMC ladder editing based on direct
memory card execution (ladder editing card function) is
unavailable.
For a personal computer connected to the FS16i/18i/21i via the
high-speed serial bus Type 2 and a personal computer connected
to the FS16i/18i/21i, however, inserting a memory card into a
card slot in the CNC enables the ladder editing card function.
The memory card utility of the FS150i with a CNC Display Unit
with Personal Computer Function can perform input/output of
only the same type of data that the standard FS15i can input
from and output to a memory card.

� When the file I/O destination is set to the personal computer
hard disk on the FS160i/180i/210i with the personal computer
function, the FS160i/180i/210i with a CNC Display Unit with
Personal Computer Function, a personal computer connected to
the FS16i/18i/21i via the high-speed serial but Type 2, or a
personal computer connected to the FS16i/18i/21i via the
Ethernet, the following file manipulation library functions
cannot be used with the C Executor:
aux_file_mount Register a memory card
aux_file_unmount Cancel registration of a memory card
aux_file_memcinfo Obtain memory card status
These functions can, however, be used when the file I/O
destination is set to the CNC card slot with a personal computer
connected to the FS16i/18i/21i via the high-speed serial bus
Type 2 or a personal computer connected to the FS16i/18i/21i
via the Ethernet.

� Position compensation and cursor control on the touch panel or
by the mouse cannot be performed. In addition, mouse dragging
cannot be used on a personal computer connected to the
FS16i/18i/21i via the Ethernet.

� Screen erasure is disabled. Use a function such as a screen saver
function of the personal computer.
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� When the CNC screen display function is terminated forcibly by
using, for example, [Ctrl]+[Alt]+[Delete], the CNC cannot
display the screen for about 30 seconds after termination. After
forcibly terminating the CNC screen display function, wait at
least 30 seconds until the CNC can display the screen, then
restart the CNC screen display function. (Any attempt to restart
the CNC screen display function immediately after its
termination will result in no response.)
In some cases with the Ethernet version, however, the CNC
cannot display the screen for about five minutes after forcible
termination. In such cases, wait at least five minutes until the
CNC can display the screen, then restart the CNC screen display
function.

� Only one CNC screen display function can be started per CNC.
On a personal computer connected to the FS16i/18i/21i via the
high-speed serial bus Type 2 or a personal computer connected
to the FS16i/18i/21i via the Ethernet, however, a CNC screen
display function window can be opened for individual CNCs at a
time.

� On the FS160i/180i/210i, pressing the [shift] key solely cannot
trigger the screen copy function.

� To switch to the loader screen on the FS160i/180i/210i, use the
[shift]+[help] ([shift]+[ESC]) keys.
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CHECKING THE PRODUCT PACKAGE

This product package software consists of the following:

� System floppy disks (for HSSB)
FANUC Open CNC CNC Screen Display Function (A02B-0207-
K770#EN07)

� System floppy disks (for Ethernet)
FANUC Open CNC CNC Screen Display Function (A02B-0207-
K772#ZZ07)

NOTE
Read the Release Note (README.TXT), provided
on the second floppy disk of this product package.
It provides detailed information on this product
package and information not described in the
operator's manual.
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ORGANIZATION OF THIS MANUAL

This manual has the following organization:

SAFETY PRECAUTIONS
Explains the general precautions which must be observed to
ensure safety when using the CNC screen display function.

PREFACE
Briefly explains the features of the CNC screen display function.
Also explains how to use this manual and provides other
information on the usage of the CNC screen display function.

1. SETUP
Explains how to set up the environment for operating the CNC
screen display function and to prepare the CNC screen display
function for use.

2. OPERATION
Explains how to use the CNC screen display function.

3. SETTING
Explains how to switch from one language to another in the
CNC screen display function, and how to change the keyboard
assignment.

APPENDIX A
Explains the alarms that are generated during the execution of
the CNC screen display function and the actions to be taken.

APPENDIX B
Explains the FS160is/180is/210is CNC screen display function.
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NOTATION CONVENTIONS

The following explains the notation conventions used in this manual:

� Menu, command, and screen notations
Example                      Explanation
[File] menu Menu names are enclosed in brackets [ ].
[Title bar] Command names are enclosed in brackets

[ ].
<OK> button Command buttons on the display are

enclosed in angle brackets < >.

� Key notations and operation
Example                      Explanation
[Enter] key Key names are enclosed in brackets [ ].
[Ctrl]+[Tab] keys When keys are to be pressed and held

down sequentially, the keys are indicated
by connecting them with +, as shown to
the left.

Direction keys The [→], [←], [↑], and [↓] keys are
collectively called the direction keys.

� Mouse operations
Example                      Explanation
Click Press a mouse button, then release it

immediately.
Double-click Click a mouse button twice in quick

succession.
Drag Move the mouse while holding down a

mouse button, then release the button at a
desired location.

� Sample screens
The screens shown in this manual are merely examples on the
FS160i.
The screens shown in this manual are merely examples.  Note
that the screen layouts and displayed file names may vary
depending on the equipment being used.
The screens shown in this manual are examples of the screens
displayed by Windows 95.  Note that the display differs a little
when Windows NT 4.0 is used.
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1 SETUP
This chapter explains how to set up the environment for operating the
CNC screen display function, and how to prepare the CNC screen
display function for operation.
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1.1 SETUP (HSSB VERSION)

This section describes information related to the setup of the HSSB
version of the CNC screen display function.

See Section 1.2, "Setup (Ethernet Version)," for explanations
about the setup of the Ethernet version of the CNC screen
display function.
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1.1.1 Operating Environment

The software operating environment for the CNC screen display
function is as follows:

� Computer
- FS160i/180i/210i with the personal computer function
- CNC Display Unit with Personal Computer Function or

personal computer attached to high-speed serial bus Type 2
(connected to the FS16i/18i/21i, FS15B, or FS15i)

� Environmental requirements
For Windows 95/98
- Pentium 100 MHz or better processor
- 16 MB of memory (minimum)
For Windows NT4.0/2000
- Pentium 120 MHz or better processor
- 32 MB of memory (minimum)

� Recommended operating environment
For Windows 95/98
- Pentium 120 MHz or better processor
- 32 MB of memory (minimum)
For Windows NT4.0/2000
- Pentium 150 MHz or better processor
- 64 MB of memory (minimum)

� Display
- Resolution: 640 × 480 or higher resolution
- Color : 256 colors or more (16-color mode cannot be used)

� Required hard disk space
- 10 MB or more

NOTE
1 The CNC screen display function runs under

Windows 95/98 or Windows NT4.0/2000.
2 Maximum performance sometimes cannot be

achieved depending on the type, performance, and
usage of the personal computer.

3 As with other Windows applications, this function is
subject to restrictions when operating in
multitasking mode. That is, the CNC screen display
function affects the execution speed of other
applications, and other applications affect the
execution speed of the CNC screen display
function.
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1.1.2 Installing the CNC Ccreen Display Function

This section explains how to install the CNC screen display function.

NOTE
Before the CNC screen display function can be
installed, operations such as driver installation and
setting of the following drivers must be performed
according to the operating environment.
• HSSB device driver
• CNC/PMC data window library
• MDI keyboard driver (FS160i/180i/210i with

personal computer function and CNC Display
Unit with Personal Computer Function with MDI
keys)

For details, refer to the Release Note
(README.TXT) on Disk 1 of the driver library
floppy disks (A02B-0207-K730#ZZ07).

Procedure for installing the CNC screen display function
1. Set Disk 1 of the system disks (A02B-0207-K770#EN07) in the

floppy disk drive.
2. Select the [Start] menu.
3. Select [Run...].
4. Enter <drive-name>:SETUP, and select the <OK> button.

(<drive-name> is the name of the 3.5-inch floppy disk drive.)
5. Install the CNC screen display function according to the

displayed messages.
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1.1.3 Uninstalling the CNC Screen Display Function

This section explains how to uninstall the CNC screen display
function.

Procedure for uninstalling the CNC screen display function
1. Choose the [Start] menu.
2. Choose [Settings], then choose the [Control Panel] command.
3. Execute [Add/Remove Programs].

The Add/Remove Programs Properties screen appears.

4. Choose the CNC Screen Display Function.
5. Choose the <Add/Remove...> button.

The uninstall function starts, asking you whether you really want
to uninstall the program.

6. To uninstall the program, choose the <Yes> button.

When the CNC screen display function has been uninstalled normally,
the function is deleted from the Windows program menu.
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1.2 SETUP (ETHERNET VERSION)

This section describes information related to the setup of the Ethernet
version of the CNC screen display function.

See Section 1.1, "Setup (HSSB Version)," for explanations about
the setup of the HSSB version of the CNC screen display
function.
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1.2.1 Operating Environment

The software operating environment for the CNC screen display
function is as follows:

� Environmental requirements
For the Windows 95/98
- Pentium 100 MHz or better processor
- 16 MB of memory (minimum)
For Windows NT4.0/2000
- Pentium 120 MHz or better processor
- 32 MB of memory (minimum)

� Recommended operating environment
For the Windows 95/98
- Pentium 120 MHz or better processor
- 32 MB of memory (minimum)
For Windows NT4.0/2000
- Pentium 150 MHz or better processor
- 64 MB of memory (minimum)

� Display
- Resolution : 640 × 480 or higher resolution
- Color : 256 colors or more (16-color mode cannot be used)

� Required hard disk space
- 10 MB or more

NOTE
1 The CNC screen display function runs under

Windows 95/98 or Windows NT4.0/2000.
2 Maximum performance sometimes cannot be

achieved depending on the type, performance, and
usage of the personal computer.

3 As with other Windows applications, this function is
subject to restrictions when operating in
multitasking mode. That is, the CNC screen display
function affects the execution speed of other
applications, and other applications affect the
execution speed of the CNC screen display
function.
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1.2.2 Installation

This section explains how to install the CNC display function.

NOTE
The CNC screen display function is realized using
socket communication (TCP/IP communication)
with the FANUC Ethernet board. Before starting to
use the function, check the following items by
referencing the FANUC Ethernet Board Operator's
Manual (B-63354EN).
• TCP/IP setting in the personal computer
• Setting of the FANUC Ethernet board and

FOCAS1 (DNC1)/Ethernet function in the CNC
• Network connection between the personal

computer and CNC

Procedure for installing the CNC screen display function
1. Set Disk 1 of the system disks (A02B-0207-K772#ZZ07) in the

floppy disk drive.
2. Choose the [Start] menu.
3. Choose [Run...].
4. Enter <drive-name>:SETUP, and choose the <OK> button.

(<drive-name> is the name of the 3.5-inch floppy disk drive.)
5. Install the CNC screen display function according to the display

messages.
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1.2.3 Uninstallation

This section explains how to uninstall the CNC screen display
function.

Procedure for uninstalling the CNC screen display function
1. Choose the [Start] menu.
2. Choose [Settings], then choose the [Control Panel] command.
3. Execute [Add/Remove Programs].

The Add/Remove Programs Properties screen appears.

4. Choose the CNC Screen Display Function (Ethernet).
5. Choose the <Add/Remove...> button.

The uninstall function starts, asking you whether you really want
to uninstall the program.

6. To uninstall the program, choose the <Yes> button.

When the CNC screen display function has been uninstalled normally,
the function is deleted from the Windows program menu.
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2 OPERATION
This chapter explains how to operate the CNC screen display
function.
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2.1 START AND TERMINATION (HSSB VERSION)

This section explains how to start and terminate the HSSB version of
the CNC screen display function, and explains the points to be noted
when the function is started.

See Section 2.2, "Start and Termination (Ethernet Version)," for
explanations about how to start and terminate the Ethernet
version of the CNC screen display function.

2.1.1 Starting the CNC Screen Display Function

The following explains the procedure for starting the CNC screen
display function and explains the points to be noted when the function
is started.

Procedure
1. Choose the [Start] menu.
2. Choose the [Programs] command.
3. Choose the [CNC Screen Display Function] command.

The following CNC Screen Display Function screen appears:
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Example 1.
CNC screen display function on the FS160i/180i/210i

Example 2.
CNC screen display function on the FS150i

4. When the resolution of the display is 640 × 480 dots, disable the
display of the title bar by choosing [Title bar] from the submenu
of [View] in the menu bar, to maximize the size of the CNC
screen on the display.
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5. To display the title bar, perform the following:
When using the mouse : Click the right button.
When using the full keyboard : [Shift]+[F10]
When using the MDI keyboard : [SHIFT]+[GRAPH]

A pop-up menu, shown below, appears. Choose [Title bar].

By choosing [Display above the task bar] from the submenu of
[View] in the menu bar, to the CNC screen displays above the
task bar. (Edition 1.11 or later)

A pop-up menu, shown below, appears. Choose [Display above
the task bar].
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NOTE
1 When the CNC screen display function is started on

the FS160i/180i/210i, the CNC display screen to be
displayed is determined according to the following
CNC parameters:
CNC parameters: Nos. 3198 and 3199
(CNC parameter for enabling the above
parameters: Bit 6 of parameter No. 3103)
When the CNC screen display function is started on
the FS150B or FS150i, the screen that was
selected on the CNC before this function is started
remains displayed. Likewise, when the CNC screen
display function is ended, the screen that was
displayed by this function is displayed on the CNC.
Note that when the PMC screen is displayed, the
screen of the CNC that was displayed before the
PMC screen is displayed is displayed. Also, when
the CNC screen display function is started or ended
with the help menu or multi-tuning function pop-up
menu displayed, these screens are cleared.

2 When the screen resolution is higher than 640 ×
480 dots, the title bar is always displayed. (You
cannot choose the [Title bar] from the menu.)
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2.1.2 Starting the CNC Screen Display Function (Multiple
Connection)

The CNC screen display function allows one personal computer to be
used for operating up to eight CNCs (Series 16i/18i/21i, FS15B,
FS15i) when these CNCs are connected to the personal computer via
high-speed serial bus Type 2. The response to manipulation for
display becomes slower as the number of connected CNCs increases.

CNC

       No.n

CNC

       No.2

CNC

       No.1

High-speed
serial bus
board No. n

High-speed
serial bus
board No. 2

High-speed
serial bus
board No. 1

.........

Personal computer
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� Starting the function
When more than one CNC is connected or can be connected, the
CNC screen display function can be executed more than once at
the same time. In this case, each time the CNC screen display
function is started, the following CNC select screen appears:

The buttons have the following meanings:
  : Executes the CNC screen display function.

When the CNC screen display function is
already running, the running CNC screen
display function is displayed on top.

  : Stops the current CNC screen display
function.

  : Terminates the CNC screen display function.

� Explanation of the list
The list contains the following information:

- General format of the list
CNC No. = 01  160/180/210  Connecting

Connection status
� Disconnect
� Connecting
� Executing
CNC model
� 160/180/210
 (Series 16i/18i/21i)
� 150B (Series 15B)
� 150 (Series 15i)
CNC number (00 to
07)
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(1) CNC number
The number of a CNC that can be connected is indicated.

(2) CNC model
The model of the CNC that is connected or which can be
connected is indicated.

(3) Connection status
Disconnect :

The power to the CNC is off, or the cable is not
connected correctly.
In this state, neither the  button nor

 button can be choosed.
Connecting :

The CNC is connected correctly.
Choosing the  button executes the
CNC screen display function.
The  button cannot be choosed.

Executing :
The CNC screen display function is running.
Choosing the  button displays the
currently executed CNC screen on top.
Choosing the  button stops the CNC
screen display function. When this button is choosed,
the connection status in the list changes from
Executing to Connecting.

NOTE
When a CNC in the Disconnect status has been
connected correctly, perform the following
operation. Then, the status indication changes to
Connecting, and the  button can be
choosed.
� With the mouse, click an arbitrary CNC in the

list.
� With the cursor keys, select another item in the

list.

The CNC to be connected can be specified using an
argument on the command line. When this argument is
used, the above Select CNC screen does not appear.
The format of the command line specification is as
follows:

CNCSCRN  /NODE = <CNC-number>
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2.1.3 Terminating the CNC Screen Display Function

The following explains how to terminate the CNC screen display
function.
As explained below, there are several termination methods. You can
use any of these methods to terminate the CNC screen display
function.

Operation 1
Terminating from a pop-up menu
Click the right button of the mouse on the screen of the CNC
screen display function. Then, the following pop-up menu
appears. Choose [Exit].

Operation 2
Terminating from the menu bar
Choose [Exit] from the submenu of [File].

Operation 3
Terminating from the title bar
Click .

Operation 4
Terminating from the keyboard
� When a personal computer connected to the

FS16i/18i/21i/15i/15B via high-speed serial bus Type 2, the
full keyboard type of the FS160i/180i/210i with the
personal computer function, or the full keyboard type of the
FS160i/180i/210i/150i with a CNC Display Unit with
Personal Computer Function are used

Press [Alt]+[F4].
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� When the MDI keyboard type of the FS160i/180i/210i with
the personal computer or the MDI keyboard type of the
FS160i/180i/210i/150i with a CNC Display Unit with
Personal Computer Function are used

Press the unlabeled key (or [FAPT])+[SHIFT]+[DELETE].

NOTE
During the termination processing for the CNC
screen display function, the following message
appears:

If the CNC screen display function is restarted while
this message is being displayed, the CNC screen
display function may operate abnormally. When
restarting the CNC screen display function, restart
the function after the above message disappears.
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2.2 START AND TERMINATION (ETHERNET VERSION)

This section explains how to start and terminate the Ethernet version
of the CNC screen display function, and explains the points to be
noted when the function is started.

See Section 2.1, "Start and Termination (HSSB Version)," for
explanations about how to start and terminate the HSSB version
of the CNC screen display function.

2.2.1 Start

The following explains the procedure for starting the CNC screen
display function from the Windows start menu, and explains the
points to be noted when the function is started.

Procedure
1. Choose the [Start] menu.
2. Choose the [Programs] command.
3. Choose CNC Screen Display Function (Ethernet) to start it.

4. When the CNC screen display function is started, the following
screen appears to specify the destination:
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When the function is started for the first time or the
 is selected, the screen changes to the following:

On this screen, enter the following items.

Host : Specify a host name (such as "CNC1") or an IP
address (such as "190.0.2.31").

Port no. : Specify the port number for the FOCAS1
(DNC1)/Ethernet function.

Timeout : Specify a timeout value for graphic data
transmission/reception in seconds. Entering 0
disables timeout processing, causing an infinite
wait.

A host name and port number can be specified using
arguments on the command line. When these arguments are
used, the above screen to specify the destination does not
appear. The format of the command line specification is as
follows:

CNCSCRNE /H=<host-name>:<port-number>
/T=<timeout-value (by default, 30)>

The /H and /T arguments can be specified at the same time.

5. Choosing the  button causes the screen to change
to the following:

NOTE
It may take several minutes for the Ethernet version
to start. Choosing  discontinues the
start sequence.



2.OPERATION                                                                                                                               B-63164EN/04

- 22 -

When the CNC is connected successfully, the CNC Screen
Display Function screen appears.

6. When the resolution of the display is 640 × 480 dots, disable the
display of the title bar by choosing the [Title bar] from the
submenu of [View] in the menu bar, to maximize the size of the
CNC screen on the display.

7. To display the title bar, perform the following:
When using the mouse :  Click the right button.
When using the keyboard :  [Shift]+[F10]

A pop-up menu, shown below, appears. Choose [Title bar].

8. By choosing [Display above the task bar] from the submenu of
[View] in the menu bar, to the CNC screen displays above the
task bar. (Edition 1.4 or later)
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A pop-up menu, shown below, appears. Choose [Display above
the task bar].

NOTE
1 When the CNC screen display function is started,

the CNC display screen to be displayed is
determined according to the following CNC
parameters:
CNC parameters: Nos. 3198 and 3199
(CNC parameter for enabling the above
parameters: Bit 6 of parameter No. 3103)

2 When the screen resolution is higher than 640 ×
480 dots, the title bar is always displayed. (You
cannot choose the [Title bar] from the menu.)
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2.2.2 Start (Multiple Connection)

The Ethernet version of the CNC screen display function allows one
personal computer to be used for operating two or more CNCs
connected over an Ethernet network (the maximum number of
connectable CNCs is determined according to the related Ethernet
limitation). The response to manipulation for display becomes slower
as the number of connected CNCs increases.

 CNC
     No.1

 CNC
     No.2

 CNC
     No.n----

Ethernet

Personal computer

� Starting the function
This function can be started using the same starting procedure
described in Section 2.2.1. Specify the host name (such as
"CNC1" or "CNC2") or IP address that matches the CNC to be
connected.

� Simultaneous Ethernet and high-speed serial bus connection
It is possible to run the CNC screen display function for a CNC
connected via the high-speed serial bus and that for the CNC
connected via the Ethernet simultaneously on a single personal
computer. To set up the functions for this purpose, perform the
setting procedures described in both Section 1.1, "Setup (HSSB
Version)," and Section 1.2, "Setup (Ethernet Version)." To start
and terminate the functions, follow the procedures described in
Section 2.1, "Start and Termination (HSSB Version)," and
Section 2.2, "Start and Termination (Ethernet Version)."

 CNC
     No.1

 CNC
     No.2

 CNC
     No.3

High-speed
serial bus board
No. 1

High-speed
serial bus board
No. 2

Personal computer

Ethernet
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2.2.3 Termination

The following explains how to terminate the CNC screen display
function.
As explained below, there are several termination methods. You can
use any of these methods to terminate the CNC screen display
function.

Operation 1
Terminating from a pop-up menu
Click the right button of the mouse on the screen of the CNC
screen display function. Then, the following pop-up menu
appears. Choose [Exit].

Operation 2
Terminating from the menu bar
Choose [Exit] from the submenu of [File].

Operation 3
Terminating from the title bar
Click .

Operation 4
Terminating from the keyboard
Press [Alt]+[F4].
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NOTE
During the termination processing for the CNC
screen display function, the following message
appears:

If the CNC screen display function is restarted while
this message is being displayed, the CNC screen
display function may operate abnormally.
When restarting the CNC screen display function,
restart the function after the above message
disappears.
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2.2.4 Termination by Means of the PMC Signal

The following explains how to terminate the CNC screen display
function by means of the PMC signal.

Not using this function does not influence the operation of the
CNC screen display function. Use it as required.

Turning on a specified machine signal terminates the CNC screen
display function. To specify the machine signal, follow the procedure
below.

1. Choose the [Close Signal…] from the submenu of [Option] in
the menu bar.

2. The Close Signal dialog box appears.

3. Enter the target PMC signal in the Signal on host text box, using

the following format, then choose the  button.

<signal-address>.<bit-position>  Example)  X0004.7

The close signal can be specified also using an argument on the
command line.
The format of the command line specification is as follows:

CNCSCRNE  /S=<signal-address>.<bit-position>

The /H, /T, and /S arguments can be specified simultaneously.
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NOTE
1 The setting of the machine signal is preserved. It is

impossible to start the CNC screen display function
if the set signal is kept turned on with the PMC
sequence program.

2 The PMC signal can be used to terminate only the
Ethernet version of the CNC screen display
function. It is not supported for the HSSB version of
the CNC screen display function.
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2.3 INPUT FROM THE KEYBOARD

This section explains the key input method.

���� Input from the MDI keyboard (MDI keyboard type of the
Series 160i/180i/210i with the personal computer function
and the MDI keyboard type of the FS160i/180i/210i/150i
with a CNC Display Unit with Personal Computer Function)
The CNC MDI keys, with some exceptions, can be used in the
manner described in the CNC operator's manual.
The CNC screen display function uses the following MDI keys
(function keys) as the [Ctrl] key and [Alt] key. When using the
original functions of these MDI keys (function keys), use the
alternative keys shown below.

 [MDI key Key used in the CNC
screen display function

Alternative key of
function key

[CUSTOM] [Ctrl] [SHIFT]+[POS]
Unlabeled (or [FAPT]) [Alt] [SHIFT]+[PROG]

NOTE
Pressing the [SHIFT] key instigates processing
within the personal computer. It is not transferred to
the CNC. Therefore, the functions performed by
using the [SHIFT] key cannot be used.
Example: [SHIFT] . . . . . . Screen copy

� Input from the full keyboard (personal computer connected
to the Series 16i/18i/21i/15i via high-speed serial bus Type 2,
full keyboard type of the Series 160i/180i/210i with the
personal computer function, the full keyboard type of the
FS160i/180i/210i/150i with a CNC Display Unit with
Personal Computer Function, or a personal computer
connected to the FS16i/18i/21i via the Ethernet)
Those keys not found on the MDI keyboard, with the exception
of the alphanumeric keys, are assigned as follows:

Full keyboard Corresponding key on the
MDI keyboard

[Insert] → [INSERT]
[Delete] → [DELETE]
[Home] → [ALTER]
[End] → [HELP]
[Page Up] → [↑PAGE]
[Page Down] → [↓PAGE]
[Esc] → [HELP]
[Tab] → [ALTER]
[Ctrl]+[F1]or [1] on numeric keypad → [POS]
[Ctrl]+[F2] or [2] on numeric keypad → [PROG]
[Ctrl]+[F3] or [3] on numeric keypad → [OFFSET/SETTING]
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Full keyboard Corresponding key on the
MDI keyboard

[Ctrl]+[F4] or [4] on numeric keypad → [SYSTEM]
[Ctrl]+[F5] or [5] on numeric keypad → [MESSAGE]
[Ctrl]+[F6] or [6] on numeric keypad → [GRAPH]
[Ctrl]+[F7] or [7] on numeric keypad → [CUSTOM]
[Ctrl]+[F8] or [8] on numeric keypad → Unlabeled (or [FAPT])
[F1] to [F10] → Relative position soft keys
[F11] → FL (leftmost soft key)
[F12] → FR (rightmost soft key)

• Input from full keyboard (personal computer connected to the
FS15B via the high-speed serial bus Type 2)
Keys not found on the MDI keyboard, with the exception of the
alphanumeric keys, are assigned as follows:

                                  

Full keyboard Corresponding keys on
the MDI keyboard

[Insert] → [INPUT]
[Delete] → [DELETE]
[Home] → [ALTER]
[End] → [HELP]
[Page up] → [↑ PAGE]
[Page Down] → [↓ PAGE]
[Ctrl]+[F1] or [1] on numeric keypad → [POS]
[Ctrl]+[F2] or [2] on numeric keypad → [PROG]
[Ctrl]+[F3] or [3] on numeric keypad → [OFFSET]
[Ctrl]+[F4] or [4] on numeric keypad → [P-CHECK]
[Ctrl]+[F5] or [5] on numeric keypad → [SETTING]
[Ctrl]+[F6] or [6] on numeric keypad → [SERVICE]
[Ctrl]+[F7] or [7] on numeric keypad → [MESSAGE]
[Ctrl]+[F8] or [8] on numeric keypad → [OTHERS]
[Ctrl]+[F9] or [9] on numeric keypad → [CNC/PMC]
[Ctrl]+[F10] or [10] on numeric keypad → [FAPT]
[Ctrl]+[F11] → [AUX]
[F1] to [F10] → Relative position soft keys
[F11] → FL (leftmost soft key)
[F12] → FR (rightmost soft key)
[Shift]+[Enter] → [CALC]

NOTE
1 The [RESET] MDI key is not assigned to the full

keyboard to prevent possible problems. When
using the [RESET] key, use that on the MDI
keyboard. (The [RESET] MDI key is effective even
when the CNC screen display function is being
executed.)

2 The key assignment of the full keyboard can be
changed. For an explanation of how to change the
key assignment, see Section 3.3.
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2.4 INPUT WITH THE MOUSE AND TOUCH PANEL

This section explains input with the mouse and touch panel.

Operation 1
Click a soft key by using the mouse .

For FS160i/180i/210i

Operation 2
Physically press a soft key on the touch panel.

NOTE
Within a CNC screen, the mouse and touch panel
can be used only for soft key operations.
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2.5 FUNCTION KEYS

This section explains how to select function keys by using the full
keyboard and mouse.

���� When the full keyboard is used
The function keys on the MDI keyboard are assigned to the full
keyboard as follows:

On FS160i/180i/210i/150i
Function key on the MDI

keyboard →→→→ Full keyboard

[POS] → [1] on numeric keypad or [Ctrl]+[F1]
[PROG] → [2] on numeric keypad or [Ctrl]+[F2]
[OFFSET/SETTING] → [3] on numeric keypad or [Ctrl]+[F3]
[SYSTEM] → [4] on numeric keypad or [Ctrl]+[F4]
[MESSAGE] → [5] on numeric keypad or [Ctrl]+[F5]
[GRAPH] → [6] on numeric keypad or [Ctrl]+[F6]
[CUSTOM] → [7] on numeric keypad or [Ctrl]+[F7]
Unlabeled (or [FAPT]) → [8] on numeric keypad or [Ctrl]+[F8]

On FS150B
Function key on the MDI

keyboard →→→→ Full keyboard

[POS] → [1] on numeric keypad or [Ctrl]+[F1]
[PROG] → [2] on numeric keypad or [Ctrl]+[F2]
[OFFSET] → [3] on numeric keypad or [Ctrl]+[F3]
[P-CHECK] → [4] on numeric keypad or [Ctrl]+[F4]
[SETTING] → [5] on numeric keypad or [Ctrl]+[F5]
[SERVICE] → [6] on numeric keypad or [Ctrl]+[F6]
[MESSAGE] → [7] on numeric keypad or [Ctrl]+[F7]
[OTHERS] → [8] on numeric keypad or [Ctrl]+[F8]

� When the mouse is used
1. Choose the [Function key] from the submenu of [View] on

the menu bar.
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2. The function switch screen appears. Choose the button of a
desired screen.

FS160i/180i/210i/150i FS150B

Button  Key on MDI keyboard Button  Key on MDI keyboard

  → [POS]   → [POS]

  → [PROG]   → [PROG]

  → [OFFSET/SETTING]   → [OFFSET]

  → [CUSTOM]   → [P-CHECK]

  → [SYSTEM]   → [SETTING]

  → [MESSAGE]   → [SERVICE]

  → [GRAPH]   → [MESSAGE]

  → [FAPT]   → [OTHERS]

NOTE
1 The  button appears when conversational

automatic programming function Symbol CAPi T for
lathe is provided.

2 The function switch screen appears at the center of
the screen for the first time. Move the screen to any
desired location. When the screen is displayed for
the second and subsequent times, the screen
appears at the location to which the screen was
moved previously.
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2.6 DATA INPUT/OUTPUT (EXCEPT FOR THE FS150B)

This section explains data input/output operations (input to and output
from the memory card and hard disk).

2.6.1 When The FS160i/180i/210i With The Personal Computer
Function or the FS160i/180i/210i/150i with a CNC Display Unit
with Personal Computer Function Is Used

� Assignment to the memory card drive
In the Series 160i/180i/210i with the personal computer function
or the FS160i/180i/210i/150i with a CNC Display Unit with
Personal Computer Function, the memory card slot locates in
front of LCD is connected to the personal computer; it is not
connected to the CNC. Therefore, the memory card is handled as
a kind of drive (removable disk) attached to the personal
computer.

To use a memory card for input/output, set up the following
parameters.
When the FS160i/180i/210i is used:

Set CNC parameter No. 20 to 4.
When the FS150i is used:

Set CNC parameter Nos. 20 to 23 to 0 or 8.

The drive to which the memory card is actually assigned varies
depending on the drive configuration in the personal computer.
Set the drive to which the memory card is assigned, by using the
procedure explained below.
In the following explanation, the memory card is assumed to be
assigned to drive D.

1. Choose [Data input/output...] from the submenu of [File] in
the menu bar.
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2. The [Data Input/Output] dialog box appears.

3. Enter the memory card drive (D:¥), then click the <OK>
button.

When the <Browse> button is pressed on the above screen,
the [Browse for Folder] dialog box appears. Choose an
appropriate folder, then click the <OK> button. Then, a
folder name can be entered.

After the above steps have been completed, every memory card
I/O operation by the CNC is performed for the memory card
(D:¥) on the personal computer.
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���� Assignment to a hard disk
The I/O destination can be assigned to a hard disk as well as the
memory card drive. Assignment to a hard disk is performed in
the same way as for a memory card drive. A drive may be
specified directly, or a subfolder may be specified. Once the
assignment is completed, the CNC data is input to or output from
the folder.
Any of the folders in the Windows file system, including the
memory card, hard disk, floppy disk, and drives connected
through a network, can be assigned.
For the FS160i/180i/210i, the contents of an assigned I/O folder
can be checked on the CNC screen.

SYSTEM/ALL-IO screen

Shown above is a sample screen displayed when the following
folder (C:¥NCDATA) is assigned. The O numbers below
[PROGRAM] indicate the program names contained in memory
in the CNC.

Hard disk in the personal computer CNC internal memory
C:¥NCDATA ¥O0010.TXT (file)

¥FOLDER (folder)
O0001
O0020
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NOTE
1 When a subfolder is specified as an I/O folder, "." or

".." is indicated. FOLDER indicates a folder name.
Any I/O operation for these folders results in an
error.

2 Only uppercase alphanumeric characters can be
displayed on the CNC screen. Any lowercase
characters included in folder names on the
personal computer are converted to uppercase
when displayed. Kana and kanji characters are not
displayed correctly.
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2.6.2 When a Personal Computer Connected via High-Speed Serial
Bus Type 2 or Ethernet Is Used

When a personal computer connected to a CNC via high-speed serial
bus Type 2 or Ethernet is used, a memory card slot is attached to the
CNC.
I/O operations for the memory card are performed in the same way as
when a personal computer is not connected to the CNC.

A folder on the hard disk in the personal computer can also be
specified as the data I/O destination by setting the following
parameters.
In case of the FS160i/180i/210i:

Set bit 0 of CNC parameter No. 0300 to 1.
In case of the FS15i (Ethernet connection is not supported) :

Set bit 2 of CNC parameter No. 7713 to 1.

When the above setting is made, all I/O operations for the memory
card attached to the CNC are changed to I/O operations for the folder
on the personal computer side.
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2.7 DISPLAYING VERSION INFORMATION

This section explains how to display information used for
maintenance such as version information of the CNC screen display
function.

Procedure
1. Choose [About...] from the submenu of [Help] in the menu bar.

2. The About CNC Screen Display Function appears.

The displayed information includes:
• Information about the version of the CNC screen display

function
• CNC type
• CNC software series
• CNC software version
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3 SETTING
This chapter explains the settings for the CNC screen display
function.
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3.1 SWITCHING BETWEEN DISPLAY LANGUAGES

This section explains how to switch from one display language to
another.

To switch between display languages, use the following procedure
(where, an example for switching from English to Japanese is given):

1. Choose [Setting...] from the submenu of [Option] on the menu
bar.

2. The Setting screen appears. Choose [Language]. Choose the
language you want to use, then choose the <OK> button.

3. The following message appears. Choose the <OK> button, then
restart the CNC screen display function.
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NOTE
1 Switching display languages in the CNC screen

display function changes only the language of the
displayed items specific to the CNC screen display
function, such as the title bar, menu bar, and pop-
up menus. The CNC screen display part is
displayed in the specified CNC display language.

2 When a language with a font not supported by
Windows is selected, the language cannot be
displayed correctly. Set a display language
supported by Windows.
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3.2 SETTING ANIMATED SIMULATION FOR TURNING

This section explains how to set the data for animated simulation for
turning.
The setting screen is displayed for the Series 160i-T/TT, 180i-T/TT,
and 210i-T (including the two-path control function).
The animated simulation for turning is valid for i series MODEL B or
later.

To modify the data for animated simulation for turning, use the
procedure explained below.

1. Choose [Setting...] from the submenu of [Option] on the menu
bar.

2. The Setting screen appears. Select [Lathe animation]. Set the
display speed of animated simulation for turning, then choose
the <OK> button.

NOTE
The display speed of animated simulation for
turning is indicated as a number of dots. The
display is refreshed each time the tool moves the
specified number of dots. The lower the speed, the
smoother the animation appears.
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3.3 CHANGING KEYBOARD ASSIGNMENT

This section explains the assignment of the MDI keys to the full
keyboard.
Changes in keyboard assignment are reflected to the key definition
file (keymat file) in the directory where the CNC screen display
function has been installed. This file is installed as read-only. Before
modifying its contents, change the file attribute.

� Changing an assignment
To change the standard assignment, use the procedure explained
below. In the explanation, an example for changing from
[Ctrl]+[Num-9] to [PROG] is used.

1. Choose [Keyboard...] from the submenu of [Option] on the
menu bar.

2. A list of the current assignments is displayed on the
Keyboard Setup screen, as follows:
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3. Choose a desired key (Num-9) of the full keyboard from the
list or the list in the combo box.

4. When the selected key is to be pressed together with the
[Ctrl] key, check the attribute item.

5. Select the corresponding MDI key (PROG) from the combo
box.

6. Click the  button.
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���� Deleting an assignment
To delete an assignment, use the procedure explained below. In
the explanation, an example of deleting the [Delete] key is used.
As the result of this deletion example, the full keyboard has no
key that functions as the [DELETE] MDI key.

1. Choose [Keyboard...] from the submenu of [Option] on the
menu bar.

2. A list of the current assignments is displayed on the
Keyboard setup screen, as follows:

3. Choose the full-keyboard key (Delete) you want to delete
from the list.

4. Click the  button.
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���� Notes on changing the keyboard assignment

NOTE
1 When both the full keyboard and MDI keyboard are

to be used, do not change the assignment. If the
setting of a key common to an MDI key is changed,
the MDI key assignment is also changed at the
same time.

2 The result of editing (modification and deletion) is
reflected by clicking the <OK> button. Clicking the
<Cancel> button cancels the edit result, restoring
the status existing before the editing.
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3.4 PS100/PS101 ALARM CLEAR

This section explains how to clear PS100/101 alarm.

Choose [Setting...] from the submenu of [Option] on the menu bar.

Select PS100 or PS101.

NOTE
This function is as same as the operation of
pressing “CAN”+”RESET” or “PROG”+”RESET”. So
if you execute this operation while the machine is
running, the RESET will occur and the machine will
stop.



APPENDIX
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A ALARMS
The alarms generated by the CNC screen display function are
explained below.

���� CNC link failed.
Explanation There is no response from the CNC.

Action

(1) Check whether the power to the CNC is turned on.
(2) When the personal computer is connected via high-

speed serial bus Type 2, check whether the cable is
connected correctly.

(3) Check whether driver installation, setting, and other
operations performed before the installation of the
CNC screen display function are correct.

(4) For a personal computer connected to the CNC via
the Ethernet, check its network setting and
connection.

���� Restart this application to restore this setting.

Explanation This alarm is generated when switching between display
languages has been performed.

Action Restart the CNC screen display function.

���� Font pattern file (%s) open failed.
Explanation The font pattern file indicated by %s does not exist.

Action

The font pattern file must be placed in the same folder as
the executable file of the CNC screen display function
(CNCScrn.exe). Copy the font file to the folder containing
the executable file. If the font file does not exist, re-install
the CNC screen display function.

���� Font pattern file (%s) is invalid.
Explanation The font pattern file indicated by %s is destroyed.

Action Re-install the CNC screen display function.

���� Keyboard allocation file (Keymatrx.dat) open failed.
Explanation The keyboard assignment file does not exist.

Action

The keyboard assignment file must be placed in the same
folder as the executable file of the CNC screen display
function (CNCScrn.exe). Copy the keyboard assignment
file to the folder containing the executable file. If the
keyboard assignment file does not exist, re-install the
CNC screen display function.
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���� Keyboard assignment file (%s) cannot save setup results as it is
read-only.

Explanation
The save setup results cannot be saved as the file
attributes for the keyboard assignment file to be
displayed by %s are read-only.

Action Change the file attributes, and cancel read-only.

���� Function key assignment file (%s) open failed;
Explanation The function key assignment file does not exist.

Action

The function key assignment file to be displayed by %s
must be in the same folder as the execution file
(CNCScrn.exe) of the CNC screen display function. Copy
the function key assignment file to the same folder as the
execution file.
When there is no function key assignment file, re-install
the CNC screen display function.

� Key definition assignment file (%s) open failed;
Explanation The key definition file does not exist.

Action

The key definition file to be displayed by %s must be in
the same folder as the execution file (CNCScrn.exe) of
the CNC screen display function. Copy the key definition
file to the same folder as the execution file.
When there is no function key assignment file, re-install
the CNC screen display function.

���� Please select folder.
Explanation No folder is selected in data I/O setting.

Action Set a correct folder.

���� Folder is not chosen.
Explanation No folder is set in data I/O setting.

Action Set a correct folder.

���� The folder does not exist or invalid folder name.

Explanation A nonexistent folder or an invalid folder name was set in
data I/O setting.

Action Set a correct folder.

���� CNC Option is not found ! Option Name: Extension
Driver/Library Function.

Explanation The CNC extension driver/library function option is not
found.

Action Purchase the option.

���� CNC Option is not found ! Option Name: CNC Screen Display
Function.

Explanation The CNC screen display function option for the CNC is
not found.

Action Purchase the option.
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���� CNC type differs from HSSB device set value.

Explanation The CNC Type of the HSSB device set value differs from
the connected CNC.

Action Change the CNC Type of the HSSB device set value to
the same Type as the connected CNC.

���� CNC not supported by CNC screen display function is
connected.

Explanation A CNC not supported by the CNC screen display function
is connected.

Action Change the CNC, or consider discontinued use of the
CNC screen display function.

���� Enter host name or IP address.

Explanation
Neither a host name nor IP address is specified in the
destination specification dialog box of the Ethernet
version.

Action Specify the correct host name or IP address.

����Enter port number.

Explanation No target CNC port number is specified in the destination
specification dialog box of the Ethernet version.

Action Specify the correct port number.

���� Enter a timeout value.

Explanation
No communication timeout value is specified in the
destination specification dialog box of the Ethernet
version.

Action Specify a timeout value (in seconds).

���� %s is not found.

Explanation An attempt to connect to a CNC having a host name or IP
address indicated with %s failed.

Action

(1) Check that the CNC is supplied with power.
(2) Check the setting of the FANUC Ethernet board.
(3) Check the TCP/IP setting in the personal computer.
(4) Check the network connection.
(5) If the CNC to be connected has been specified using

a host name, check the setting of the HOSTS file and
DNS server. Alternatively, try to connect using an IP
address.

���� The signal setting is invalid.

Explanation No close signal is set in the Close Signal dialog box of the
Ethernet version.

Action Specify the correct close signal.
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B CNC SCREEN DISPLAY FUNCTION FOR
THE FS160is/180is/210is

The specification of the FS160is/180is/210is CNC screen display
function is somewhat different from that of the FS160i/180i/210i
CNC screen display function. This appendix explains the
FS160is/180is/210is CNC screen display function.

Restrictions
(1) Operating environment

� This software is dedicated to the FS160is/180is/210is with
a Display Unit for is Series CNC and the
FS160is/180is/210is with the personal computer function.

NOTE
The FS160is/180is/210is with a Display Unit for is
Series CNC and the FS160is/180is/210is with the
personal computer function are hereinafter
collectively called the FS160is/180is/210is.

 
(2) Display

� The VGA mode (256 colors) is not supported.

The other properties of the FS160is/180is/210is CNC
screen display function are the same as those of the
FS160i/180i/210i.



B-63164EN/04                    APPENDIX B.CNC SCREEN DISPLAY FUNCTION FOR THE FS160is/180is/210is

- 55 -

Checking The Product Package

This product package software consists of the following:

� System floppy disks (for HSSB)
[MODEL A]

FANUC Open CNC CNC Screen Display Function (HSSB)
for Windows CE (A02B-0207-K771#ZZ07)
* For FS160is/180is/210is MODEL A with

WindowsCE2.0/2.12
[MODEL B]

FANUC Open CNC CNC Screen Display Function (HSSB)
for Windows CE (A02B-0207-K774)
* For FS160is/180is/210is MODEL B with

WindowsCE3.0

� System floppy disks (for Ethernet)
[MODEL A]

FANUC Open CNC CNC Screen Display Function
(Ethernet) for Windows CE (A02B-0207-K773#ZZ07)

[MODEL B]
Not supported

NOTE
1 Read the Release Note (README.TXT) on the

floppy disk of this product package. It provides
detailed information on this product package and
information not described in the operator's manual.

2 The CNC screen display function (Ethernet) is
realized using socket communication (TCP/IP
communication) with the FANUC Ethernet board.
Before starting to use the function, check the
following items by referencing the FANUC Ethernet
Board Operator's Manual (B-63354EN).
� TCP/IP setting on the FS160is/180is/210is side
� Setting of the FANUC Ethernet board in the CNC

loaded with that board and the Ethernet
functions

� Confirming connection between the
FS160is/180is/210is and the CNC loaded with
the FANUC Ethernet board over the network

** Windows CE is a registered trademark of Microsoft Co., Ltd.
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B.1 INSTALLING THE CNC SCREEN DISPLAY FUNCTION

The HSSB version of the CNC screen display function has been
preinstalled in the FS160is/180is/210is. Usually, it need not be
installed again. To upgrade it or install the Ethernet version, follow
the steps below.

Procedure for installing the CNC screen display function

(1) Copy the following file (self-extracting form) to an empty folder
on a development personal computer and execute.
[MODEL A (A02B-0207-K771#ZZ07) for HSSB]

WinCE200.exe for WindowsCE2.0
WinCE212.exe for WindowsCE2.12

[MODEL A (A02B-0207-K773#ZZ07) for Ethernet]
CSDFEis.exe for WindowsCE2.0

[MODEL B (A02B-0207-K774)]
CSDFWCE300.exe for WindowsCE3.0

(2) "CNCScrn" folder and "Setupis.exe" file will be melted.
(In case of CSDFEis.exe, only "CNCScrnE" will be melted.)

(3) Copy "Setupis.exe" and the "CNCScrn" (or "CNCScrnE") folder
to an ATA card.

(4) Switch on the CNC.
(5) Insert the ATA card into the PCMCIA slot of the

FS160is/180is/210is.
(6) Open My Computer on the desktop, and check that the ATA card

is automatically recognized as "Storage Card2."
(7) Open "Storage Card2" and start Setupis.exe.
(8) Check the check box for "CNCScrn" (or "CNCScrnE") to be

installed, and choose the "OK" button or press the "INPUT" key.

NOTE
1 Inserting an ATA card having a copy of a program

into the CNC, then switching it on causes
"Setupis.exe" to start automatically. After the
function is installed, remove the ATA card, and
switch the CNC off and on again.

2 To uninstall the function, delete the following folder.
¥Storage Card¥FANUC¥CNCScrn
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B.2 START AND TERMINATION

This appendix explains how to start and terminate the CNC screen
display function, and explains the points to be noted when the
function is started.

Start procedure (HSSB version)
1. Open the ¥Storage Card¥FANUC¥CNCScrn folder.
2. Start CNCScrn.exe.

Start procedure (Ethernet version)
1. Open the ¥Storage Card¥FANUC¥CNCScrn folder.
2. Start CNCScrnE.exe.

NCBOOTis can be used to cause the CNC screen display function to
start automatically when the power is switched on. As for details,
refer to the NCBOOTis operator's manual (NCBOOTis.doc) which is
included in the following disks.
MODEL A : A02B-0207-K733#ZZ07
MODEL B : A02B-0207-K736

Title bar display
To display the title bar, press the unlabeled key + [V], and
choose [Title bar] from the [View] menu.

Termination procedure
Press the unlabeled key + [F], and choose [Exit] from the [File]
menu.
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B.3 INPUT FROM THE KEYBOARD

The key input method for the FS160is/180is/210is is the same as that
for the MDI keyboard type of the FS160i/180i/210i with the personal
computer function. See Section 2.2, "Input from the Keyboard," in
this manual for details.

Full keyboard
The FS160is/180is/210is is not equipped with a full keyboard.
So it cannot be operated using a full keyboard.
But in case of FS160is/180is/210is MODEL B, it is possible to
use 101 keyboard by connecting via USB interface.
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B.4 DATA INPUT/OUTPUT

To set up the data input/output unit, press the unlabeled key + [F], and
choose [Data input/output...] from the [File] menu.
The FS160is/180is/210is is equipped with a compact flash memory
card instead of a hard disk. To specify the data input/output unit,
enter:

¥Storage Card¥...¥... (where ... is any folder name)

Alternatively, to use the ATA card in the front PCMCIA slot, enter:

¥Storage Card2¥...¥... (where ... is any folder name)
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B.5 SWITCHING BETWEEN DISPLAY LANGUAGES

The FS160is/180is/210is CNC screen display function can be used in
English or Japanese whichever is selected. (Japanese version of
FS160is/180is/210is only)

To select either language, press the unlabeled key + [O], then choose
[Setting...] from the [Option] menu.

See Section 3.1, "Switching between Display Languages," in this
manual for details.
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B.6 COPYING THE CNC SCREENS (WindowsCE2.12 OR
LATER)

The FS160is/180is/210is CNC screen display function can output the
CNC screen images which are displayed in the client area into the
files as bitmap data (bmp file).

Operation
(1) Press the unlabeled key + [F] to display pull-down menu.
(2) Then choose [Capture(P)] from the [File(F)] menu.
(3) Copying is finished when the sand clock icon is disappeared.

Attentions
(1) This function is valid only for FS160is/180is/210is CNC Screen

Display Function.
(2) The folder for outputting the bitmap data is specified by [Data

input/output...]. (See Appendix2.4)
The bitmap file name is “HDCPY001.bmp”.
When outputting some screens, the file names are as follows.
HDCPY001.bmp, HDCPY002.bmp, HDCPY003.bmp…

(3) The serial number (HDCPY***) is counted up automatically
until the CNC Screen Display Function is ended. When the CNC
Screen Display Function is restarted, the serial number is
refreshed and then the old one is overwritten.

(4) The screen image is output as bitmap data with 256 colors. The
size of bitmap file is about 300Kbyte and it takes about 4
seconds to output.

(5) The bitmap data does not include the pull-down menu and the
sand clock.

(6) The blinking characters and cursors are not output correctly.
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B.7 HOST SELECTION (ETHERNET VERSION ONLY)

When the Ethernet version of the CNC screen display function is
started for the first time, a screen for selecting the host CNC loaded
with the FANUC Ethernet board for connection appears.
Choosing the "OK" button with the host CNC selected from the list
starts the CNC screen display function. To add a host CNC to the list,
choose the
"Edit ..." button. The edit screen appears.
The result of editing is saved to the "¥Storage
Card¥FANUC¥HostNc.dat" file.

HostNc.dat file format:
Host-name  IP-address  port-number  [#comment]

� Each item is separated from another with a space or tab
code.

� A line that begins with # is a comment.
� This file is in UNICODE.

Example:
# This is a sample HostNc.dat
Host1 192.168.0.1 6000
Host2 192.168.0.2 6000 # A comment can be written here, too.
# End of file

When the CNC screen display function is started for the second or
subsequent time, the CNC selection screen does not appear. Instead, it
is connected to the host CNC selected previously. To connect to
another CNC, start "¥Storage Card¥FANUC¥CNCScrn¥SetHost.exe"
and select the desired CNC.

If no network setting is completed for Windows CE, the CNC screen
display function displays the network setting screen.
Be sure to specify IP Address and Subnet Mask. Default Gateway is
optional. If you do not want to use the option, enter: "0.0.0.0"
Choosing the "OK" button causes the setting to be saved.

Once you change the network setting, switch the power off and on
again to restart the system.
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B.8 COMMUNICATION LOG FUNCTION (ETHERNET VERSION
ONLY)

If an error occurs within the CNC screen display function, the
communication log function is used to save the information about the
cause of the error to a file for early problem solving.

The communication log is saved to the "¥Storage
Card¥FANUC¥CncScrnE.log" file.

Displaying the communication log
The current communication log can be viewed using the
"¥Storage Card¥FANUC¥LogView.exe" utility.
When the "LogView.exe" utility is started, the Open dialog box
appears. Choose "CncScrnE.log" using an arrow key, then click
the [OK] button. The log display screen appears.
How to operate the log display screen is explained below.

� Moving the cursor
To move the cursor, press an arrow key on the keyboard.
The [Page Up] and [Page Down] keys on the keyboard can
be used to shift the page.

� Saving to a text file
To convert the log file to a text file and save the text file,
choose [Save As] from the [File] menu.

� Changing the setting
To change the setting of the log viewer, choose [Settings]
from the [File] menu. The following item can be re-set.
Log information (described later)

� Updating information
To display the current contents of the log file, choose
[Refresh] from the [View] menu.

� Changing the sequence of display
To start information display with the latest piece of
information, check [Reverse] in the [View] menu (default).
Turning off the check starts information display with the
least recent piece of information.
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Controlling log information
The output of the CNC screen display function can be specified
using four different levels.

Level 0
No log is output.

Level 1 (default)
Information about TCP/IP start/stop events and all errors
that occurred is output.

Level 2
In addition to the information output at level 1, information
about all events related to TCP/IP is output.

Level 3
In addition to the information output at level 2, all
communicated data is output.

Choosing [Settings] from the [File] menu displays the Settings
dialog box. The "Log Level" tag of the dialog box can be used to
check and change the currently effective level.

Choosing "FocaslisE.log" from the list displays the current level.
Choosing a new level, then clicking the [OK] button asserts the
chosen level.
To put the selected log level in effect, restart the CNC screen
display function.
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B.9 TERMINATION BY MEANS OF THE MACHINE SIGNAL
(ETHERNET VERSION ONLY)

Turning on a specified machine signal terminates the CNC screen
display function. To specify the machine signal, follow the procedure
below.

(1) Choose the [Close Signal...] from the [Option] menu. A dialog
box for specifying the signal appears.

(2) Enter the target PMC signal in the Signal on host text box, using
the following format, then choose "OK."

<signal-address>.<bit-position>    Example)  X0003.7

NOTE
1 The setting of the machine signal is preserved. It is

impossible to start the CNC screen display function
if the set signal is kept turned on with the PMC
sequence program.

2 The signal for the PMC connected via a local bus or
HSSB can be specified at the same time. In this
case, make settings also for the signal on the
HSSB side. If the PMC signal is specified as both
signal on the host side and signal on the HSSB
side, the CNC screen display function is terminated
when the PMC signal on either side becomes on.
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